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Introduction
Welcome to Columns Max, the fast-paced falling blocks game!
Columns Max is a fast-paced falling-blocks game with 256-color graphics, sound 
effects, and background music which add a pleasant twist to an apparently common 
game.

The rules of Columns Max are simple.    Pieces, consisting of three colored blocks 
appear at the top of the pit and drop toward the bottom.    When a piece reaches the 
bottom, it stops moving and a new piece appears at the top.    When pieces are 
dropping, the order of their colored blocks may be changed, and the pieces themselves 
can be moved left or right.    By manipulating pieces as they fall, you can control the 
place where they land, and their final color pattern.    The object of the game is to drop 
pieces so that sets of matching colored blocks are formed.    These sets must be at least 
three blocks in a vertical, horizontal, or diagonal direction.    When such a formation of 
colored blocks is formed after a piece is dropped, all blocks in the formation will 
disappear and the blocks in the rows above will drop down to take their place.    The 
game ends when the pit is entirely filled with colored blocks, so the more blocks you 
remove, the more pieces you'll have room for, and the longer you'll be able to play.

System Requirements
Columns Max has been beta tested on Pentium systems with 16-32MB of memory.    At 
least 4 MB RAM is required for play, with 8MB recommended.    The memory 
requirements are quite steep because Columns Max needs to load large music and 
graphics files.    To enjoy the background music and sound effects, you will need to have 
a sound card with wave playing ability supported by Windows (such as Microsoft Sound 
System or Creative Labs Sound Blaster compatibles).

See troubleshooting for advice with common problems.

Related Topics:
How to play a Game
Controls
Scoring
AutoPlay



Scoring
You receive points for dropping 
blocks, and for forming sets of 
colored squares.

The number of points you receive for forming sets of colored blocks increases as the 
number of blocks involved increases.    The minimum set is three blocks, with five being 
the maximum in any single direction.    You receive more points when cascades occur.    
Cascades occur when the blocks which fall as a result of blocks disappearing earlier, 
cause more sets of three or more blocks to form in a single round.

You also receive 1 point for each row that a block falls when you drop it.    In addition, 
there are ways of scoring large bonuses by making special plays, but you'll have to 
discover them for yourself!

Related Topics:
How to play a Game
Controls
AutoPlay



How to Play A Game
To quickly get started, select Begin Game from the File menu, or just use the key 
sequence Control-B.    If you are just starting out, you will begin playing on Level 1.    
Use the default J, K, and L keys to move the falling piece left, rotate its colored blocks, 
or move it to the right, respectively.    To drop the piece, press the SPACE key.    You can 
change the key bindings for these actions by selecting the Change Controls option from 
the Options menu.

To play a two-player game, select Two Player Game from the File menu.    To play a two-
player game against a computer opponent, select Play Against Computer from the File 
menu.

Related Topics:
Controls
Scoring
AutoPlay



Registering
Columns Max is $15 shareware 
and free for those people who've 
paid for previous versions.    
Registered users may order a 
Bonus Disk Set either at the time 
of registration, or at a later date.
Registered users of Bricklayer 
may register at a reduced rate.

If you enjoy and play Columns Max, please send in the $15 shareware fee.
It is not very much compared to the cost of a commercial game, and it motivates me to 
keep improving Columns Max as well as to work on new games.    If you play, please 
pay.    Upgrades to new versions of Columns Max are always free for registered users.    
Those who register will also be kept informed of new version releases, as well as the 
releases of any new products.

If you want to register Columns Max:
· send a US$15 check payable to Yevgeny Gurevich to the address listed below.    If 

you live outside of the U.S., please send an international money order (preferred) or 
cash, since checks drawn on foreign banks are sometimes difficult to clear.    Please 
do not send Eurocheques or credit card numbers.

If you are registering the 32-bit Windows 95 Columns Max, specify that you are 
registering “Columns Max32”.

If you want to register Columns Max and are a registered user of Bricklayer:
· send a US$10 check payable to Yevgeny Gurevich to the address listed below.    If 

you live outside of the U.S., please send an international money order (preferred) or 
cash, since checks drawn on foreign banks are sometimes difficult to clear.    Please 
do not send Eurocheques or credit card numbers.

Click here to view the registration form (select File/Print to print it).

Site licenses are available - please contact me for more details.

post: Yevgeny Gurevich
Vanilla-Extract Software
P.O. Box 391
Falls Church, VA 22040-0391
U.S.A.

America Online: Yevg
Internet email: yevg@aol.com
CompuServe: 76101,2317



For fast response, request to have the code mailed to you electronically.

Once you have registered, you will receive registration information, containing your 
registration name and registration code.    Once you have the registration 
information, you should enter it into the game.    There are two ways to perform this 
step: select Register from the opening shareware notice window, or select the Register 
menu item from the Help menu once you see the main game window.

A box asking for your registration name and code will appear.    Enter your name and 
code exactly as they appear in your registration information (mailed to you after 
reception of your registration fee.)    If the code is correct, you will be notified 
immediately that the game has been registered.    From that point on, registration 
notices will no longer appear, and your copy will be clearly identified as registered to 
your or your organization.    You may opt to remove the “Registered To:” information 
from the bottom of the game window through the preferences dialog box.

You may be interested in ordering the Bonus Disk Set for an additional $10.00.

Related Topics:
What  ’  s interesting in version 2.5  
Registration Form



Columns Max32 for Windows v2.5 Registration Form
[Name]
Title           _______
Last Name       ____________________ 
First Name      ____________________         Initial __

[Address]
if USA:
    Address     _______________________________________________
    City        _______________________________________________
    State, Zip  __   _____-____

if Outside USA:
        Address ________________________________________________
                ________________________________________________
                ________________________________________________
                ________________________________________________
        Country ____________________________

email address   _____________________
Would you like to be notified about
new products/releases via email ?  [ ] Yes        [ ] No
[Additional Information]
Where did you find Columns Max ?
[] Internet (FTP/WWW/Gopher)            [] America Online
[] Friend                               [] The Microsoft Network
[] Software club                        [] Other online service
[] book CD                              [] store-bought CD
Pricing Information
Description                           Qty   Unit Price       Total
Single-User Registration                        $15.00
Rebate for registered users of Bricklayer     - $ 5.00
Additional Single-User License                  $ 7.50
10-machine site license                        $100.00
25-machine site license                        $200.00
Unlimited site license                         $400.00
Latest Version on disk                          $ 3.50*
Bonus Disk Set of Music and Graphics            $10.00*
(includes latest version)
Total Enclosed:
------------------------------------------------------------------
* Only registered users or users registering with this order are eligible
  to purchase disk sets.  Price includes media and shipping charges.

Thank you for registering Columns Max32 for Windows v2.5!
Please send US$15 for each copy of Columns Max32 to be registered to:
      Yevgeny Gurevich

Vanilla Extract Software
P.O. Box 391
Falls Church, VA 22040-0391
USA



AutoPlay
The AutoPlay feature lets the computer play a game of Columns Max.    The computer 
plays at two levels of intelligence - Quick ‘n Dirty and Deep Thought.

The fast player thinks quickly but is not as good at playing the game as the slower and 
smarter player, which uses the Next Piece for lookahead.    On systems like i486DX2-
66's, the smart player is faster than the dumb player on an i486SX-33.

Related Topics:
None



Bonus Disk Set
The Bonus Disk Set is a collection of music and graphics files to make Columns Max 
even more varied and exciting.    The disk set contains the latest version of Columns 
Max, and additional disks, consisting of original music compositions, background 
graphics modules, new piece graphic designs, and several pit graphics.

This disk set is only available to registered Columns Max users.

You may order the disk set together with your registration, or may do so separetely at a 
later time.    Users who have registered previous versions of Columns Max are welcome 
to purchase it.

The price is just $10.00 (this is in addition to the registration fee) which already includes 
the shipping and media costs.

If you have Columns Max32, please specify that you are ordering the Bonus Disk Set 
for Columns Max32, as music and graphics modules are not interchangeable between 
Columns Max and Columns Max32.

If you are a registered Bricklayer user who has purchased the Bricklayer Bonus Disk 
Set, please don’t purchase the Columns Max Bonus Disk Set, as it contains the same 
bonus modules.    Instead, you can use these modules with Columns Max, just as you 
use them with Bricklayer.

Related Topics:
Registering



What’s interesting in version 2.5 ?

Version 2.5 of Columns Max 
includes more tuned control of the 
game graphics and animated 
pieces.

This version of Columns Max has 
support for selecting entire directories 
of modules at a time.

Pit graphics are changed once per level, while 
backgrounds and piece graphics are changed 
once per game.    These options are available 
through the preferences dialog box, and by 
right-clicking to get a Properties menu (see 
next item).

Graphics modules can be selected 
simply by right-clicking in the main 
game window.    Right-click in the pit to 
change pit graphics, right-click on a 
piece inside the pit to change piece 
graphics, or right-click outside of the pit 
over the background to change 
background graphics.

The list of available files is taken from the 
directory where the currently-selected graphic 
resides.    Most likely, this is the directory where 
Columns Max is installed.    You can select 
individual files or the entire directory.    If you 
select the directory, you can opt to have 
sequential selection of files (default) or select 
Randomize Directory to have Columns Max 
choose modules at random.

Piece size can be changed from the 
piece properties menu.

The size of game pieces can be selected 
directly from the piece graphics properties 
menu (right-click on a piece in the game 
window to see this menu).

Music modules can be selected simply 
by right-clicking in the main game 
window over the music selection status 
window.

This window appears in the lower-lefthand 
corner of the screen and denotes the name of 
the music module that is currently loaded.    
Right-click on the status window to select from 
a list of available files in the current directory.    
You can remove this status window from the 
Music Preferences.    The list of available files 
is taken from the directory where the currently-
selected music module resides.    Most likely, 
this is the directory where Columns Max is 
installed.    You can select individual files or the 
entire directory.    If you select the directory, you 
can opt to have sequential selection of files 
(default) or select Randomize Directory to have 
Columns Max choose modules at random.

You can play Columns Max against a 
human or computer    opponent.    More 
details are provided in the two-player 



page.

The game duration (in 
minutes:seconds form) is now recorded 
for each game that you play.

This duration is stored in the high-scores table 
if you get a high score.

The size of the game pit can be 
changed with sliders in the General 
Preferences dialog box.

You can change the number of rows and 
columns in the game pit independently.    The 
default values are 7 columns by 14 rows.

You can maximize the game window.

You can enable smooth dropping of 
pieces.

Smooth dropping draws pieces more smoothly 
as they descend through the game pit.

You can enable smooth animation. If an animated piece file is selected, smooth 
animation will animate the piece “real-time” 
instead of relying on the animation to occur 
only when the piece drops.

High Color pieces modules are 
provided.

Two modules which can take advantage of 16-
bit color video cards are provided.    These 
modules, CMDEF_HI and BURST_HI, should be 
selected only if you are in high-color (16-bit 
color) mode.

Your high scores can be uploaded to 
the Microsoft Kid’s Space.

When you enable this option in the game 
Preferences, Columns Max32 will attempt to 
contact the space and send your high scores 
(or they may be sent later if you are not logged 
on).    You can view your current ‘space high 
scores by selecting “Game Space High 
Scores” from the Options menu.    Only scores 
from default games (no decaying pieces or 
heavy blocks enabled , and a pit size of 7 by 
14) will be eligible for uploads.

Related Topics:
Registering Columns Max



Changing Background Graphics
Background graphics are bitmaps which are tiled in the main game window, usually 
different for each level in the game.    You may select alternate graphics modules in the 
“Graphics” sheet of the preferences dialog box, or by right-clicking on the main game 
window background to bring up the Background Properties menu.

You can select a file or an entire directory of modules.    If you select a directory, 
Columns Max will select a new backgrounds module each time you start a new game.    
By default, Columns Max will cycle through the modules sequentially.    You can also 
direct Columns Max to select modules randomly by selecting Randomize Directory from 
the background properties menu.

Once a new module is selected, it is loaded instantly and loads by default the next time 
that Columns Max is started.

If you are selecting alternate graphics modules by selecting Browse from the “Graphics” 
sheet of the preferences dialog box, the File-Open dialog box may not show the drive 
where Columns Max is installed.    In this case, you will need to change to the directory 
where the alternate graphics modules are installed.

Related Topics:
Changing Piece Graphics
Changing Music Modules Changing Pit Modules



Changing Pit Graphics
Pit graphics are bitmaps which are drawn over the black pit area of the game.    By 
default, no graphics are shown to improve game performance.    You may select 
graphics modules to be drawn in the pit area (and enable them being shown) from the 
“Graphics” sheet of the preferences dialog box, or by right-clicking on the game pit to 
bring up the Pit Properties menu.

You can select a file or an entire directory of modules.    If you select a directory, 
Columns Max will select a new pit module each time you start a new game.    By default, 
Columns Max will cycle through the modules sequentially.    You can also direct 
Columns Max to select modules randomly by selecting Randomize Directory from the 
pit properties menu.

Once a new module is selected, it is loaded instantly and loads by default the next time 
that Columns Max is started.

Make sure to enable the drawing of the graphics by selecting the Show Pit Graphic 
checkbox in the Graphics sheet of the Preferences dialog box, or by selecting Show Pit 
Graphic from the pit properties menu.    Once this option is enabled, all future games will 
use pit graphics.

A new type of pit module is a multipit module.    This type of module is similar to a 
normal pit graphic, except that there are several graphics grouped into a single file.    As 
you play a game which uses a multipit module, a new graphic starts to inch its way up 
the game board to replace the previous graphic, controlled by the number of rows that 
you clear.

Please note that when playing with larger than normal blocks, the game performance 
can suffer heavily on machines with slow graphics cards.

Related Topics:
Changing Piece Graphics
Change Music Modules
Change Background Graphics



Changing Music Modules
Music modules are used as the source of the background music which plays during a 
Columns Max game. You may select alternate music modules from the Music sheet of 
the preferences dialog box, or by right-clicking on the Music Selection field at the bottom 
of the game window to bring up the Music Properties menu.

Once a new module is selected, it is loaded instantly and loads by default the next time 
that Columns Max is started.

The easiest way to select alternate music modules is to click on the Browse button in 
the Music sheet of the Preferences dialog box and double click on available .BM2 files. 
If the File-Open dialog box does not show the drive where Columns Max is installed, 
you will need to change to the directory to one where the alternate music modules are 
installed.

Artists or programers may contact me for specification of the .BM2 file format so that they may 
develop third-party music modules for use with the game.    If you would like to have your music 
included in future distributions or bonus disk sets, please contact me.    Please ONLY send 
material which you have rights to distribute.

Related Topics:
Changing Piece Graphics
Changing Background Graphics
Changing Pit Modules



Changing Piece Graphics
Piece graphics are the little bitmaps which are drawn to represent each of the colored 
squares in Columns Max blocks. You may select alternate graphics modules in the 
“Graphics” sheet of the preferences dialog box, or by right-clicking on the main game 
window background to bring up the Piece Properties menu.

You can select an file or an entire directory of modules.    If you select a directory, 
Columns Max will select a new piece module each time you start a new game.    By 
default, Columns Max will cycle through the modules sequentially.    You can also direct 
Columns Max to select modules randomly by selecting Randomize Directory from the 
piece properties menu.

Once a new module is selected, it is loaded instantly, and loads by default the next time 
that Columns Max is started.

Related Topics:
Changing Background Graphics
Changing Music Modules
Changing Pit Modules



Music and Sound 
Columns Max contains terrific sound effects 
and background music.    Through the 
Options menu, you can elect to hear just the 
background music, just sound effects, or 
both.

Sound effects and background music can be individually toggled using the Music and 
Sound Effects menu items in the Options menu.    A check mark next to each of the 
items means that it is active for the current and all following games.

Control over whether background music and sound effects are loaded each time 
Columns Max is executed is handled by the Load Music check box in the Music sheet of 
the preferences dialog box.    For users who do not have wave-output sound support, 
the Load Music option can be deselected (no check mark).    This will prevent Columns 
Max from loading the background music and speed the total load time.    All sound and 
music options will be disabled for future loads as well.    This option may be checked off 
to enable loading music at any time.

Wave Mixing
This version of Columns Max, 2.5, uses the Microsoft DirectSound library.    You must 
have DirectX installed for the music and sound to work.    DirectX can be installed from 
DirectX distributions with the DXSETUP.EXE program.

The music .WAV files and .BM2 modules are Copyright Opinicus Microtechnologies, 
and may be freely distributed only as part of the Columns Max for Windows game for 
use by the Columns Max program.    See the distribution information for more details.

Sound Quality
If you experience poor sound quality while playing Columns Max, please try to turn off 
Sound Effects and see if the background music is smoother.    If you prefer, you can 
toggle either sound effects or music off, and leave the other on.

Related Topics:
Changing Music Modules



Controls
Columns Max may be played using keyboard controls or a joystick.    The default are 
keyboard controls shown below:

j Move Left
k Rotate Colors
l Move Right
SPACE Drop
a Push Down

The numeric keypad keys are always active as control keys in addition to any user-
selectable settings.    On the numeric keypad, the 4, 5, 6, and 0 act the same as the j, k, 
l, and space.

Keyboard control is customizable with the Change Controls item in the Options menu.    
When you select Change Controls a dialog box lets you select the player for whom you 
are changing the controls, and the type of control (keyboard or joystick) that player will 
use.    For single-player games, the controls for Player 1 are used.

If you select Keyboard controls, five edit fields allow you to edit the keys that will be 
used to control the pieces.    These keys are saved in the Columns Max preferences file 
and are active in the current game of Columns Max, and all future games as well.    In 
addition to the alphanumeric keys, you can specify the cursor four keys, nine numeric 
keyad keys, or the special insert/delete/home/end/pageup/pagedown keys. Controls 
may be identical for both players in a two-player game.

If joystick controls is selected, you should select the Calibrate Joystick button to 
calibrate your joystick for use with Columns Max.    Joystick control of pieces is as 
follows:

Move the piece left or right by moving the joystick left or right.
Rotate a piece by pressing button #1 on your joystick.
Drop a piece of pressing button #2 on your joystick.
Push a piece by moving the joystick down.

Related Topics:
How To Play A Game
Scoring



Comments, Suggestions, Bug Reports
I look forward to hearing from you.    If you encounter problems while playing Columns 
Max, I would appreciate any information that you can provide, such as your system 
configuration and a detailed description of the problem.    Suggestions for improvements 
are also welcome.

Send general Internel email to
yevg@aol.com

or, via CompuServe to
76101,2317

or, via America Online to
Yevg

Postal mail is welcome at
Yevgeny Gurevich
Vanilla-Extract Software
P.O. Box 391
Falls Church, VA 22040-0391



Columns Max Preferences
Columns Max has many options which you can set to customize the game to fit your 
taste.    Select Preferences from the Options menu.    A preferences properties dialog 
box appears with tabs for different sheets.    Click on the tabs to select among general 
options, graphics options, and music options. Sheets contain check boxes to toggle 
system settings, and Browse buttons to select alternate graphics and music files.    The 
options available through these sheets are summarized below:

Fast Left/Right Motion If this option is on, holding down the move left or right key 
continuously will move pieces faster.

Pause on Lose Focus If this option is on, the game automatically pauses when 
you switch from Columns Max to another program or 
window.    With this option off, the game continues even if 
you move on to another program.    Unselecting this option 
is useful if you want to see the computer play in the 
background.    The music will not play once you switch from 
Columns Max so as not to hog the sound resources.

Force 16-Color Mode On some 16-color-only systems may speed up the game.

Load Music on startup By default this option is on and tells Columns Max to load 
music files each time the program is loaded.    Setting this 
option off will prevent music from being loaded, speeding 
load time but preventing you from listening to the 
background music.

Blocks Size Specifies the size of the game blocks and the 
corresponding game window.    The slider ranges from 
“normal” to 25%, 50%, 75%, and 100% (double size) 
larger.    The game window will be scaled according to this 
setting.    If the game window will be larger than can be 
displayed on your system, a warning dialog box will come 
up, letting you cancel the size-change.    Larger blocks and 
gameboards are useful for systems with high-resolution 
displays.    They’re easier for some children to play with as 
well.

Remove Notice If checked, gets rid of the “Registered To:” status box at 
the bottom of the game window.
 

Show Pit Graphic Enables the display of the pit graphic in the game board.    
When larger than normal-size blocks are also set, using 
this feature can heavily impact graphics performance.



 
Columns Specifies the number of columns in game pit.    The default 

number of columns is 7.
 

Rows Specifies the number of rows in game pit.    The default 
number of rows is 14.
 

Show Game Time Displays the length of the current game in minutes:seconds 
form.

Show Musical Selection Displays a status window with the name of the currently-
playing background music module.    Right clicking on this 
status window will bring up the Music Properties menu.

Smooth Animation On systems with fast processors or graphics adapters, this 
will enable smooth animation of animated pieces.    This is 
a graphically-intensive setting and if your system 
performance is poor, you will want to unselect this option.

Smooth Dropping Specify that pieces will appear to drop in a smoother 
manner.    As above, this is a more graphic-intensive setting 
and if your system performance is poor, you will want to 
unselect this option.

The input box in the “General” sheet allows you to enter how many rows of debris are 
placed on the screen at the start of each game.    You can challenge yourself or the 
computer by increasing the debris.

The Music, Background Graphics, Pit Graphics, and Piece Graphics browse buttons 
allow you to select alternate music and graphics modules.    Just click on the appropriate 
browse button to get a file/directory listing dialog box.

Related Topics:
Changing Background Graphics
Changing Piece Graphics
Changing Pit Modules
Music and Sound Options



Two-Player Games
Columns Max allows two players to play together.    Select Begin Two Player Game 
from the File menu.    Players take turns on the same gameboard.    Scoring is just as it 
is for single-player games, except that separate scores and number of rows cleared are 
kept track for each player.    At the end of the game, either or both players may earn high 
scores.    High scores for two player games are kept separate from single-player games.

Players may use the same keyboard bindings for movement, or use different controls.    
They may even have one player use a joystick while the other uses a keyboard.    See 
Controls for instructions on how to modify keyboard and joystick settings.

A human player can also elect to compete against the computer.    Select Play 
Against Computer from the File menu.    The human player alternates controlling 
pieces with the computer.    Scoring is just like it is for two-player games.    In the high-
scores table, entries for players which competed against the computer are marked with 
a ‘C’.



Common Problems and Solutions
Due to rather steep memory and processor requirements, some users may experience 
problems starting, or playing with Columns Max.    This section details some common 
problems and their solutions:

Columns Max won't start 
up

Often due to insufficient memory or incompatibilities with sound 
hardware.

Try creating a file called CMAX.INI in your WINDOWS directory 
and putting the following lines there:

[Settings]
LoadMusic=0

This will force Columns Max to ignore the music and sound 
settings and not load any music files.    You will be able to play, 
but will have no music or sound effects.

Background music stops 
playing during the game

Some problems involved with mixing the sound effects and 
background music result in the background music sometimes 
stopping after a few minutes of playing.    You have several 
options.

· If you select to have music but no sound effects, this problem 
does not seem to occur.

· You may press the TAB key to restart the music during play.

Game seems extremely 
slow

On some slower computers, the processing needed to play the 
background music and sound effects becomes the major time 
sink.

Try unchecking the music and/or sound options.    Without 
background music, the game will feel snappier on slower 
computers.

Also, try changing to normal-size game pieces if you are using 
large pieces.

Audible clicks when 
pieces drop

The sound mixing is done in software and is not perfect.    Some 
audible clicks may be heard when pieces drop and background 
music is on.    This is especially evident when using AutoPlay.

If you like the background music, getting rid of the sound effects 
by unselecting them from the options menu will make the music 
sound much smoother.    If you value the sound effects more, try 
unselecting the music option.    The clicks will be less evident.

Make sure that your soundcard is supported by DirectSound for 
optimal performance.




